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Understanding Pro Card Reallocation 

 

1.   The Corporate Purchasing Card is the premier tool recognized by the University for small 

purchases of products and services that facilitate the business needs of departments 

throughout campus.   The Corporate Purchasing Card Program is based on a State of 

Maryland Contract with Bank of America and VISA. The Purchasing Card is accepted 

anywhere VISA is accepted and may be used for any authorized purchase of $4,999 or 

less.  

 

Information about the card and program may also be obtained from: 

 

•  Joseph Evans - Dir., General Procurement, jevans@af.umaryland.edu 

•  Kathy Bordenski – Asst. Dir.-Business Development Prog., 

kbordenski@af.umaryland.edu  

2.   End of Procedure. 
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Reallocating Pro Card Transactions (Rev. 08/19/09) 

 

1.   Navigate to the Pro Card Transactions page. 

 

Click the Purchasing link. 

 

2.    

Click the Procurement Cards link. 

 

3.    

Click the Reconcile link. 

 

4.    

Click the Reconcile Statement link. 

 

5.   Three pieces of information are required to search: 

 

- Role Name 

- Cardholder EmplID/Affiliate ID (OR the entire Card Number) 

- Billing Date 

 

Begin by selecting the Role Name. 

 

Click the Role Name list. 

 

6.   PCard Viewers are able to view transactions, but not reallocate. 

 

PCard Reallocators are able to view and reallocate.   

 

Two Role Names display on the drop down list when you have been assigned Viewer 

rights to one card and Reallocator rights to another card.   

 

One Role Name displays when you have Viewer or Reallocator rights to only one card.    

 

Click the UMB Reallocator list item. 

 

7.   Enter the cardholder's Employee ID (or Affiliate ID) in the EmplID field. 

 

NOTE:  Use the Look up EmplID button to display the list of cardholders for whom 

you have rights to reallocate (or view). 

 

Enter the desired information into the EmplID field. Enter a valid value e.g. "005162". 
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8.    

Click the Look up Billing Date button. 

 

9.   Select the desired Billing Date 

 

10.   You have entered Role Name, cardholder Empl ID (or Affiliate ID) and Billing Date.   

 

The system now has enough information to perform the search.  

  

Click the Search button. 

 

11.   The Collapse (Ctrl + Y) button hides the Menu to create more viewing area. 

 

NOTE:  To unhide the Menu, click the Expand (Ctrl + Y) button which will be located 

on the far left of the page (just below the eUMB logo) when the Menu is hidden 

(collapsed). 

 

Click the Menu Collapse button. 

 

12.   Observe the Status column.  Your search has returned only Staged transactions - those 

available for reallocation in eUMB Financials.   

 

NOTE:  Closed transactions are those that are no longer available for reallocation in 

eUMB Financials.  They have been "swept" to the General Ledger during overnight 

processing on the 15th of each month (the 10th for July).   

13.   The Transaction tab displays transactions by Transaction Date with the oldest 

transactions appearing at the top and the most recent at the bottom of the Trans Date 

column. 

 

To re-sort results by any column, click the column's underlined label.  (Example:  to 

re-sort by employee name from A to Z,  click the “Employee Name” label once.  To re-

sort from Z to A, click the label a second time.) 

Click the Trans Date link. 

 

14.   Merchant information - including reference numbers - are located behind the Merchant 

name link. 

 

View additional information on the Merchant named HH OUTDOORS.  

 

Click the Merchant link. 

 

15.   The Merchant Details page offers additional information on the vendor.  Vendor-

specific reference numbers (such as Federal Express tracking numbers) may appear in the 

City field.   

 

Click the Return (Esc) button. 
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16.   The Account Distribution page is used to view or reallocate expenses associated with a 

specific transaction.  PCard Reallocators reallocate from this page.  PCard Viewers will 

be able to view, but not reallocate. 

 

Navigate to the Account Distribution page using the Distribution button to the right of 

each transaction. 

 

Click the Distribution button. 

 

17.   The Account Distribution page supports reallocations to one or more chartstrings.  In 

this example, a PCard Reallocator will reallocate an expense to more than 

one chartstring.   

 

To reallocate to more than one chartstring: 

  -- enter the desired Amount on the first line 

  -- modify the chartstring as needed 

  -- click the Add New Rows button (+) to add a second row 

  -- modify the Amount and chartstring as needed 

  -- to include additional chartstrings repeat from Add New Rows  

 

NOTE:  The total amount reallocated must EXACTLY equal the Billing Amount. 

18.   We want to leave $200.00 expensed against the default chartstring.  Change the Amount. 

 

Enter the desired information into the Amount field. Enter a valid value e.g. "200.00". 

19.   Next, add another row by clicking on the Add New Rows button (+). 

 

Click the Add New Rows button. 

 

20.   A prompt box will appear (upper left) requesting the number of rows to be added.  

Accept the default of 1 row. 
 

NOTE:  Adding rows one at a time lets eUMB track the remaining balance for you. 
 

Click the OK button. 

 

21.   Notice what happened when you added ONE row: 

 

-- The system calculated and displayed the remaining balance in the Amount field.  

In this example the remaining balance is $51.87.   

 

-- The default chartfields were copied to the newly inserted row.  When reallocating 

among multiple chartstrings, continue to add a new row and modify the chartstring until 

you have reallocated the entire expense. 

 

NOTE:  When reallocating 100% of an expense from the default chartstring to a 

different chartstring, simply enter the new chartstring on the first line. 



Job Aid 

 
 

 Page 4 Date Created: 9/2/2010 
 

22.   Select the appropriate chartstring. 

 

REMINDER:  To select a chartstring, you will need to know... 

  

-- Project Business Unit (PCBU) 
-- Project ID 

-- Account 
-- Tx Dept (if applicable) 

 

Begin by going to the Projects Information page. 

 

Click the Projects link. 

 

23.   The Projects Information page displays the current PCBU and Project.  To reallocate to 

a different chartstring, complete the following information:   

 

-- Project Business Unit (PCBU) 

-- Project 
 

NOTE:  eUMB Financials allows you to look up codes or key in the codes if you know 

them.  In this example, we will look them up. 

 

Click the Look up Project Business Unit button. 

 

24.   Select the appropriate Project Business Unit from the list.   

 

In our example, the Project Business Unit is Fed G&C - Standard. 

 

Click the 00184 list item. 

 

25.   Next, look up the appropriate Project ID. 

 

Click the Look up Project (Alt+5) button. 

 

26.   As of 03/01/2006, NEW Project ID = 00 + OLD FAS account number. (Example:  

OLD '5-23002' = NEW '00'+'5-23002' = NEW Project ID 00520032) 

 

Since there are hundreds of Project IDs in eUMB Financials, we want to narrow our 

search by entering the first few numbers of the Project ID in the Project field. 

 

Enter the desired information into the Project field. Enter a valid value e.g. "005". 

27.   Click the Look Up button. 
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28.   A list of all Project IDs beginning with '005' is returned.   

 

Select Project ID = 00520032. 

 

Click the Search Results table. 

 

29.   Return to the Account Distribution page to complete the chartstring. 

 

Click the OK button. 

 

30.   Notice that Owner Dept,  Program and (in some cases) Fund have been auto-populated 

based on the Project ID.    (If this is a Project with Cost Sharing, Fund will not auto-

populate. Enter or select the correct Fund value.)    

 

Notice that the chartstring we added is owned by another department (10304000). 

 

We still need to validate Account and Tx Dept. 

31.   We want to use the Account for IT Supplies, but we don't know the exact number.   

 

We will look up the exact Account number. 

 

Click the Look up Acct (Alt+5) button. 

 

32.   The Record Navigator shows that 300 (or more) possible Accounts (boxed in blue).   

 

Narrow the search by entering the first few numbers of an Account. 

 

Enter the desired information into the Account field. Enter a valid value e.g. "397". 

33.   Click the Look Up button. 

 

34.   The full Account that we need is '3975 - IT Supplies'. 

 

Click the Search Results table. 

 

35.   Finally, determine whether or not you need to change the Tx Dept (Transaction 

Department).   

 

The Transaction Department is a user-defined reference field.  For most Pro Card 

transactions, you will not need to change the Transaction Department.   Here's a 

guideline: 

 

   -- When reallocating to a chartstring owned by your department, the Tx Dept = 

Owner Dept.   

 

   -- When reallocating to a chartstring owned by another department, the Tx Dept 

usually = your Dept ID.   
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36.   Verify that all Chartfields are correct and complete.  Please pay close attention to 

your Chartfields! 
 

If the reallocation contains an invalid Chartfield combination,  the Reallocator will 

receive an error.   

 

The chartstring must be valid to leave the page and save the reallocation.   

 

Return to the Transaction page to save the reallocation. 

 

Click the OK button. 

 

37.   PCard Reallocators can add explanatory Comments.   

 

PCard Viewers cannot add comments, but they can read existing comments. 

 

Click the Comments button. 

 

38.   Enter the desired information into the Comments field.  Enter a valid value e.g. "The 

first 40 characters of the Comments field appear in RAVEN.". 

39.   When you have completed your comment, return to the Transaction tab.   

 

Click the OK (Enter) button. 

 

40.   To SAVE your reallocation and comments you must SAVE this page!  
 

NOTE:  The system will allow you to save after completing a single reallocation or after 

completing a group of reallocations.  It is your choice. 

 

Click the Save button. 

 

41.   One last thing before we leave reallocations... 

 

Budget Status will appear as 'Not Chk'd' until overnight processing occurs.  During 

overnight processing, the system will adjust chartstring balances in eUMB Financials 

according to your reallocation.    

 

NOTE:  eUMB Financials is set to record and track chartstring balances. It is not set 

to check the total dollar amount available in each chartstring.   

 

Budget Status indicates whether or not chartstring balances have been adjusted yet: 

     VALID = Chartstrings ARE adjusted 

     NOT CHK'D = Chartstrings NOT YET adjusted; check next morning. 
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42.   The value in the Redistrib column will be set to “Yes” when a transaction has been 

reallocated.   

 

NOTE:  It is possible for a PCard Reallocator to change the Redistrib indicator (Yes/No) 

inadvertently when re-opening a transaction.  Each click on the 'OK' button changes the 

indicator (No to Yes or Yes to No).  If you do not want to change the indicator, click the 

'Cancel' button. 

43.   You have successfully completed reallocating Pro Card expenses between a default 

chartstring and another chartstring.  You also entered and saved a comment regarding the 

reallocation. 

 

Information on requesting a Pro Card and Pro Card usage guidelines can be found on 

the UMB Procurement website at  

http://www.procurement.umaryland.edu/ 

End of Procedure. 
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Viewing Chartstrings Using UMB Projects by Department Report (05/17/10) 

 

1.   Begin by navigating to the UMB Projects by Department Report on the General 

Ledger menu in eUMB Financials. 

 

Click the General Ledger link. 

 

2.   For easier viewing, you may want to maximize your Internet Explorer window.   

 

Continue navigating to the UMB Projects by Department Report.   

 

Click the General Reports link. 

 

3.    

Click the UMB Projects by Department Rpt link. 

 

4.   A Run Control ID is required to run a report in eUMB Financials.  The system uses Run 

Control IDs to track your report request through all stages of its creation.   The following 

statements are true in eUMB Financials: 

 

     - Run Control IDs can be used to run any report within eUMB Financials.  

 

     - They can be re-used.  You do not need to create a new Run Control ID each time you 

run a report. 

 

     - A Run Control ID manages one report request at a time.  

  

     - To run more than one report at the same time, create more than one Run Control ID. 

 

     - Run Control IDs cannot be deleted. 

5.   If you haven't set up any Run Control IDs in eUMB Financials, you will need to Add a 

New Value.   

 

(Otherwise, you can click the Search button on Find an Existing Value tab, then select 

from the list that's returned.) 

 

Click the Add a New Value tab. 
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6.   Run Control ID names can contain uppercase, lowercase or mixed characters.  They 

cannot contain spaces.  Insert an underscore if you wish to separate words. 

 

Name your Run Control ID. 

 

Enter the desired information into the Run Control ID field. Enter a valid value e.g. 

"project_by_dept". 

7.    

Click the Add button. 

 

8.   The UMB Projects by Department Report can retrieve by... 

 

     - a single Owner Department ID (enter ID in Department field) 

 

     - a group of related departments (enter highest level ID in Department field)  

 

This report will not retrieve data without a Department ID in the Department field. 

 

In this example we will run the report for a group of related departments by entering a 

high level Department ID.  You could also use the Lookup button to search for the  

Department ID.  The Lookup button is located to the right of the Project field.   

 

Enter the desired information into the Department field. Enter a valid value e.g. 

"10417000". 

9.    

Click the Run button. 

 

10.   Review the Process List on the Process Scheduler Request page: 

 

     - a check should appear in the Select checkbox 

 

     - the name of the report should appear under Description 

 

     - Type and Format should remain 'Web' and 'PDF' 

 

     - all other settings should remain unchanged   

 

Click the OK button. 

 

11.   Note that a Process Instance number (boxed in blue) now appears beneath the Run 

button.  This is your indication that you have successfully submitted your report.    

 

Make note of the Process Instance number.  You will use the Process Instance 

number later to locate the report you wish to view.  
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12.   Both Report Manager and  Process Monitor pages provide the ability to...  

 

     - monitor report progress/status 

     - view report results 

     - email report results 

     - print report results 

     - save a copy of report results 

 

In this example, we will use Process Monitor.  You could also follow similar steps to 

use Report Manager.   

13.    

Click the Process Monitor link. 

 

14.   You may wish to collapse the menu to give yourself more viewing space. 

 

Click the Menu Collapse button. 

 

15.   Your User ID (your Employee or Affiliate ID) should appear in the User ID field. 

 

Reports run previously are available online for up to 35 calendar days after the run 

date.   

 

For direct access to reports run at another time, use the following menu path:  

PeopleTools > Process Scheduler > Process Monitor. 

16.   The UMB Projects by Department Report usually takes a few minutes to run to 

success.   

 

It is possible to check the status of your report by clicking the Refresh button 

periodically and viewing the Run Status and Distribution Status columns.   

 

This report has not finished running yet.  Completed reports will show Run Status = 

Success and Distribution Status = Posted.  Refresh the page for a status update. 

 

Click the Refresh button. 

 

17.   The report has finished running.  When Run Status = Success and Distribution Status = 

Posted, you will be able to view the report.  View details on the report. 

 

NOTE:  If you have submitted multiple reports, use the Process Instance number 

(boxed in green) to identify the report you wish to view. 

 

Click the Details link. 

 

18.    

Click the View Log/Trace link. 
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19.   The UMB Projects by Department Report provides both viewing and downloading 

options (boxed in blue).  We will view results first, then download and import results into 

Excel. 

 

Click the .PDF link. 

 

20.   Report results are displayed in a new window.  Maximize the window for easiest 

viewing. 

 

Results represent all of the requested department's projects as recorded in eUMB 

Financials.   

21.   To increase or decrease display size, use the zoom percent (boxed in green above). 

 

Action buttons for the following additional options are boxed in blue above: 

 

      - Save a Copy 

      - Print 

      - Email 

      - Search  

 

The Help menu located at the top of the page provides specific directions for using each 

of these features. 

22.   Report results for UMB Projects by Department Report can also be downloaded and 

imported into Microsoft Excel.  The next series of frames will detail the steps to 

download and import results into Excel. 

 

NOTE:  You can download results successfully without viewing the .PDF version of the 

report first.  However, to save time you may wish to review results before going through 

the steps required to download to Excel. 

 

Close the .PDF version of the report. 

 

Click the Close button. 

 

23.   The .txt link is used for downloading data to be imported into Excel. 

 

Right-click the dept_project.txt link. 

 

24.    

Click the Save Target As... menu. 

 

25.   The File Download and Save As dialog boxes open.   

 

Name the file using the File name field. 

 

Enter the desired information into the field. Enter a valid value e.g. 

"dept_project_110706". 
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26.    

Click the Save button. 

 

27.   Next we will import the report results into Excel.  Close the Download complete dialog 

box. 

 

Click the Close button. 

 

28.   Minimize the eUMB Financials window.   

 

Click the Minimize button. 

 

29.   Launch Microsoft Excel. 

 

Click the start button. 

 

30.    

Click the Microsoft Office Excel 2003 menu. 

 

31.   Open the downloaded text (.txt) file containing the report results. 

 

Click the File menu. 

 

32.    

Click the Open... menu. 

 

33.   Search for the text file containing downloaded results. 

 

Click the button to the right of the Files of type field. 

 

34.   Expand the search to all file types, including text (.txt) files. 

 

Click the All Files list item. 

 

35.   Open the text file we saved earlier:  dept_project_110706.txt.   

 

In this example, we will double click on the file name to open the file.  (Single clicking 

the file name, then clicking the Open button will also work in Excel.) 

 

Double-click the desired entry in the list. 

 



Job Aid 

 
 

 Page 6 Date Created: 9/2/2010 
 

36.   The Text Import Wizard opens.  For this report, we need only 2 of the 3 steps in the 

wizard to make selections that will accurately import the text file into Microsoft Excel.  

(Other reports may require all 3 steps.) 

 

In Text Import Wizard - Step 1, confirm the following default selections: 

 

     - Delimited is the file type selected (boxed in blue) 

     - The saved location of the text file you are importing appears next to "Preview of 

file..." (boxed in blue) 

 

Click the Next button. 

 

37.   In Text Import Wizard - Step 2, you will... 

 

     - change the Delimiter from Tab to Other 

     - specify the Other delimiter symbol 

     - finish the import 

 

Begin by unchecking the Tab checkbox.  

  

Click the Tab checkbox option. 

 

38.    

Click the Other checkbox option. 

 

39.   Enter the Other delimiter.  Use the "pipe" delimiter, a symbol that  looks like a vertical 

line:  |.  On PC keyboards it is usually located on a key just above the right Enter key. 

   

Enter the desired information into the Other field. Enter a valid value e.g. "|". 

40.   Notice that the text displayed in Data preview is now lined up in columns that are 

separated by a continuous vertical line. 

 

Click the Finish button. 

 

41.   You have successfully imported the report results into an Excel worksheet! 

 

Name and save the Excel worksheet. 

 

Click the File menu. 

 

42.    

Click the Save As... menu. 
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43.   Save the file as an Excel worksheet. 

 

Display the Save as type options. 

 

Click the button to the right of the Save as type field. 

 

44.   You may need to scroll to the top of the dropdown list to see the Microsoft Excel option. 

 

Click the Microsoft Excel Workbook list item. 

 

45.   Save the new Excel worksheet containing report results. 

 

Click the Save button. 

 

46.   You have successfully imported your text file into Microsoft Excel and saved your new 

worksheet.    

 

We will finish with two formatting steps that will make it easier to work with your data in 

this Excel worksheet: 

 

     - Format all column headers (titles) if you will need to use the AutoFilter, Data Sort 

or PivotTable features on Excel's Data menu. 

 

     - Adjust all column widths to display all characters      

47.   Select the row containing the column headers (titles) - Row 1.   

 

Click the Row 1 cell. 

 

48.   Bold the column headers (titles).  Applying a format to the header titles (Row 1) will 

make it possible to use AutoFilter, Data Sort or PivotTable features with this data.  

 

Click the Bold button. 

 

49.   All column headers (titles) are now bold. 

 

Next, re-format column widths so that all characters are visible.   

 

Select the entire worksheet by clicking the blank cell directly above the Row border titled 

'1'. 

 

Click the blank cell. 
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50.   With the worksheet selected, place your mouse pointer on top of the vertical line between 

columns A and B.   

 

When you are in the right spot, your mouse pointer will display a double- pointed arrow 

pointing left and right.  Hold the mouse steady. 

 

Double-click the cell margin cell. 

 

51.   De-select the worksheet by clicking anywhere in the data area (not on the bolded 

headers). 

 

Save the formatted worksheet. 

 

Click the Save button. 

 

52.   You have successfully run, viewed and downloaded results from the UMB Projects by 

Department Report. 

 

Questions on report results should be directed to: 

     - Sponsored Projects Accounting and Compliance for Grants and Contracts 

     - Financial Services General Accounting for all other sources of funds  

End of Procedure. 
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